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1. GETTING STARTED

1.1 Starting a MAPLE session

On most systems a MAPLE session is started by double clicking on the MAPLE
e o
icon Lx . In the UNIX X Windows version, MAPLE is started by entering the
command xmaple. In the command-line (tty) version, the Maple logo appears
followed by the > prompt.

In most versions a window with menus will appear. See Figure 1.1 below. At
the top are the menus File, Edit, View, Insert, Format, Spreadsheet, Options,
Window and Help. Beneath are two rows of buttons. The first row of buttons
is called the tool bar and contains 24 buttons:

B Create a new worksheet.

Open an existing worksheet.

Open a specified URL.

Save the active worksheet.

) [ED) | | B

Print the active worksheet.

Cut the selection to the clipboard.

Copy the selection to the clipboard.

Paste the clipboard contents into the current work-
sheet.

| | ) | <

Undo the last operation.

|V

Undo the last “undo.”

5 Insert MAPLE commands.

T Insert text.

[>] Insert a new MAPLE input region after the cursor.

=4| Remove any section enclosing the selection.
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2 The Maple Book

=

o

2

Enclose the selection in a subsection.

Go back in the hyperlink history.

Go forward in the hyperlink history.

Interrupt the current computation.

Set magnification to 100%.

Set magnification to 150%.

Set magnification to 200%.

Display nonprinting characters.

Resize the active window to fill the available space.

Restart.

The next row is called the context bar and contains five buttons:

()

{

{1t

L

Toggle the expression display between mathematical
and MAPLE notation.

Toggle the expression display between inert text and
executable MAPLE command.

Auto-correct the expression for syntax.
Execute the current expression.

Execute the worksheet.

The > prompt will be in the worksheet window. Don’t worry about the buttons
too much at this stage.
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Figure 1.1 MAPLE worksheet window.

1.2 Different versions of MAPLE

The current version of MAPLE is MAPLE 7 . The previous version was

MAPLE 6 . Before that, there was MAPLE Vv Release 5 , MAPLE V
Release 4, and way back in 1994, we had MAPLE vV Release 3. This book covers
MAPLE 7. The change from MAPLE 6 to MAPLE 7 was not a big one so most of
the book applies to MAPLE 6. Occasionally we will point out differences between
the earlier versions.

1.3 Basic syntax

In MAPLE the prompt is the symbol >. MAPLE commands are entered to
the right of the prompt. Each command ends with either “” or *”. If the
colon is used, the command is executed but the output is not printed. When
the semicolon is used, the output is printed. Try typing 105/25: followed by a
Return (or Enter).
> 105/25:

Observe that the output was not printed. Now type 105/25;

> 105/25;

Below in Figure 1.2 is a rendering of how this looks in the worksheet window.
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<& Untitled (1] - [Server 1]

[> 105/25: 2
> 105/25;
21
5
[> |
=l

Figure 1.2 MAPLE commands with output.

Try these
> 105/25-1/5;
4
> %+1/5;
21
5
> Uh;
4

Observe that MAPLE uses exact arithmetic. The percent sign % refers to the
previous result. The double percent %% refers to the result before the previous
result. It is possible to refer back 3 lines using %%%, but one cannot refer back
any further. The percent sign % is called the ditto operator.

Warning: In MAPLE v Release 4 (and earlier versions), the ditto operator was
the double quote character ". The two double quotes "" were used to refer to
the result before the previous result, and to refer back 3 lines one used triple
double quotes """.

One of the most common mistakes is to omit the semicolon or colon.

> 105/25

Warning, incomplete statement or missing semicolon
> 105/25;

syntax error, unexpected number

Don’t panic! MAPLE has interpreted this to mean 105/25 105/25, hence the
syntax error. MAPLE also gave a warning about the missing semicolon! If you
forget the semicolon, simply type it on the next line.

> 105/25
>
21/5

See Section 1.3 for a method for editing mistakes.

(13—

9

Results can be assigned to variables using the colon-equals
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Getting Started 5

> f:=Y%;

f:=21/5
> G:= -1/5;

G:=-1/5
> f+g;

21/5+¢g

> #0bserve that Maple is case sensitive.
>  f+G;

Note that comment lines begin with #. In the first line of our session we used
the ditto operator %. Remember, if you are using MAPLE VvV Release 4 (or an
earlier version), use " as the ditto operator.

1.4 Editing mistakes

MAPLE has built-in editing facilities. On most platforms, lines of input can be
edited using the arrow keys and the mouse. Cutting and pasting is also possible
with the mouse. In the Windows version, you can select input by highlighting
with the mouse, then you can copy, cut, and paste by using Control C, x, and v
as usual. In the command-line (or tty) version, MAPLE has two built-in editors:
emacs and vi. Use the help command 7editing for more information.

> 105/25
> 105/25;
syntax error, unexpected number
Just click the mouse after 105/25, enter a semicolon, and press enter.
> 105/25;
21/5

The vi editor can be invoked using the Esc key.

1.5 Help

Ever since MAPLE V (Release 4) came out, MAPLE has had a fabulous
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interactive help facility. Click on Help and a menu should appear:

Introduction

Help on Context Ctrl+F1
New User’s Tour
What’s New

Using Help
Glossary

Topic Search ...
Full Text Search ...
History ...

Save to Database ...
Remove Topic ...
Balloon Help ...
Register Maple 7 ...
About Maple 7 ...

Select Full Text Search. A little window should appear. In the Word(s) box,
type floating point arithmetic then click on . A search is then
made of the interactive help manual. A list of topics should appear in the
Matching Topics box. See Figure 1.3.

Full Text Search X

“whord(s) |f|0ating paint arithmetic | é'é'fEH'"""EI

Matching Topics:

Apply |
updates v52 [1.00] - oK
numerics  [0.99] |

float  [0.98)

updates Maple? numerics  [0.98) Cancel
updates w43 [0.98]

updates w5 [0.98)

numernicrefs  [0.97)

Maple_floats [0.97)
newuzertopicl3 [0.97)
updates Maplef \whatzComing  (0.97]

evalf [0.97
Fecl [rn n]1 =
W Same 'window ¥ Goodness of Match

Figure 1.3 Full Text Search window.

Select evalf with the mouse, then click on |Apply| A help window should
appear with information on the evalf command. Click on .

Now go back to the Help menu and select Introduction. A new window
should appear offering you a list of topics to explore.

If you know the name of a command, then you can select Topic Search in
the Help menu.
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Getting Started 7

To return to our original worksheet window, click on Window and select
Untitled(1)-Server(1).

Help can also be accessed directly from the worksheet. Try
> 7evalf

The evalf help window should appear. In the command-line version, this infor-
mation will appear below the cursor.

Now try selecting Balloon Help in the Help menu. Next move the cursor onto
a button and a little bubble should appear, giving a brief description. Keep this
option until you are familiar with the buttons and menus.

The command 7index provides a list of categories: expression, function,
misc, module, etc. For instance, ?index[function] gives a list of MAPLE’s
standard library functions. For more information on navigating through the
worksheet environment, see ?7worksheet.

1.6 A sample session and context menus

Open a new worksheet by pressing D . Enter the following into the work-
sheet:

> Int(x/sqrt(1+x"4),x);

“.”

and hit return after you type “;”. You should have something like this:

> Int(x/sqrt(1+x"4),x);

/de
V142t

The Int function is for calculating integrals. More information can be found in
Section 5.7. Now click on the integral (above) with the right mouse button. A
menu should appear:

Copy
Differentiate
Integrate
Evaluate
Complex Maps
Integer Functions
Simplications
Conversions
Plots

vy

vVVyVYyYVYY

This menu is called a context menu. When you click on MAPLE output, such
a menu will appear. It won’t always be the same menu. The menu depends
on the type of object you click, hence the name context menu. Now select
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Differentiate and click on b | Magically MAPLE has taken the deriva-
tive with respect to x:

>  Int(x/sqrt(1+x"4),x);

/ x dzr
V1+z4
> RO := diff(Int(x/sqrt(1+x"4),x),x);

T

RO = ——
V14t

Naturally, MAPLE found that

d / T d T
— T = .
dz | 1+ z4 V1424

Now, click on the integral again and this time select Evaluate in the contex
menu. This time MAPLE evaluates the integral:

> Int(x/sqrt(1+x"4),x);

/de
V14 x4

\%

=]

R
]

value (Int (x/sqrt (1+x"4) ,x));

1
Rl := 5 arcsinh(z?)

> RO := diff(Int(x/sqrt(1+x"4),x),x);

T

RO = ——
V1+a?t

MAPLE found that

1. _
= —sinh~! 2%

/de
V1424 2
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Getting Started 9

Click on the output with name RO, and a different context menu will appear:

Copy
Differentiate >
Integrate |
Factor

Simplify

Expand

Approximate >
Solve

Numerical Solve
Rationalize
Combine

Collect

Complex Maps
Integer Functions
Constructions
Simplifications
Conversions
Plots

VYyVYVYVYYVY VY

Select Plots and press 2-0 Plat . MAPLE produces a graph of the
See Figure 1.4.

T

Vital
> smartplot(RO);

function y =

0.6

0.4+

0.2

Figure 1.4 A smartplot.

We will learn a lot more about plotting in Chapter 6.
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10 The Maple Book

Before going on we should save our work. Click on File and a menu appears:

Save Setttings
v AutoSave Settings

New Ctrl+o
Open ...

Save Ctrl+s
Save As ...

Export As >

Close Ctrl+F4

Print Preview ...
Print Setup ...

Print ... Ctrl+P

Exit Alt+F4

Click on Save. A Save As window appears. In the File name box type chla.mws.
Then click on . The worksheet has been saved as the file chla.mws. Here
mws is a file type which stands for MAPLE worksheet.

1.7 Palettes

So far we have seen how to enter MAPLE

commands by typing after the

MAPLE prompt >, and by using a context menu. Another method is to use

palettes. Open a new worksheet by pressing

D . Now click on View and a

menu appears:

v' Toolbar
v' Context Bar
v’ Status Bar

Show Object type

Palettes >

Zoom Factor >

Bookmarks >

Back

Forward

Hide Content >

Show Invisible Characters
v" Show Section Ranges Shift+F9
v' Show Group Ranges F9

Expand All Sections
Collapse All Sections

© 2002 by Chapman & Hall/CRC



Getting Started 11

Select Palettes, slide to the right, and another menu appears:

Symbol Palette
Expression Palette
Matrix Palette
Vector Palette
Show All Palettes
Hide All Palettes

In MAPLE 7 there are four palettes: the Symbol palette, the Expression
palette, the Matrix palette, and the Vector palette. In Chapter 9 we
will use the Matrix and Vector palettes. For the time being let’s select
Expression Palette ‘ A window should appear. See Figure 1.5.

d d .
Jo | Jo| Ealmra| 2 [lime
b b=c | b=c | ik |bB—c

d+b|o-b|o=b|aofb|o=b|0:b
ab oy, Yo E"E ol ||:|.|

e | In |log| sin | cos | tan

Figure 1.5 The Expression palette.

Let’s start with something simple. In the Expression palette press |a-b|.

> GF - %D
MAPLE has produced a template for an expression of the form (a — b). Notice
B Now type 105/25.

> (105/25 - %7);
Notice that 105/25 has been entered where gfg was. Now hit the Tab key.

> (105/25 - BB

MAPLE is now waiting for us to type the second number. We type 1/5.
> (105/25 - 1/5);

We hit Return ( or Enter):

> (105/25 - 1/5);

4

Do you see how the Expression palette works? Many other types of expressions
can be entered in this way. You should be able to figure out the possible expres-
sions by looking at the buttons in the palette. Try each button and experiment.
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12 The Maple Book

To open the Symbol palette, click on View, select Palettes, slide right, and
select | Symbol Palette ‘ See Figure 1.6.

alply|d|le|&(n|oft|x|rlpr
vig|lolrm|p|o|t o] | X |V o
AIBITIA|IE|Z|H|®|T |[K|AM
N|IE|(O|II|P|Z|T|Y|®|X|¥|Q
€ || |{

Figure 1.6 The Symbol palette.

The Symbol palette is used for entering Greek letters and some mathematical
constants such as e and 7. Try out some of the buttons.

1.8 Spreadsheets

Click on Insert. A menu should appear:

Text Ctrl+T
Standard Math Ctrl+R

Maple Input Ctrl+M
Standard Math Input Ctrl+G
Execution Group >
Plot >
Spreadsheet

Paragraph >
Section

Subsection

Hyperlink...

Object...

Page Break Ctrl+Enter

Select Spreadsheet. A spreadsheet appears in the worksheet:

B
n|5:|[:||3|J

(=T LY B Y - O I

d

Bin o]

Figure 1.7 A MAPLE spreadsheet.
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Getting Started 13

Notice that the upper left-most cell (A1) is highlighted. There are four new
buttons in the context bar:

H.l, Fill a range of cells.

H! Evaluate all stale cells.

B#| Accept the input and evaluate it.

" | Restore input to the previous value.

Type n and press enter. The symbol n should appear in cell A1. In cell A2 type
1 and press enter. Now click on cell A2 and select the first column of cells up to

cell A9 by holding the mouse button down. Now click on H.l . A Fill window

should appear. Enter 1 for Step Size and press . The numbers 2, 3, ..., 8
should appear in cells A3, A4, ..., A9. Type x"n-1 in cell Bl. We now have

2™ — 1 in cell B1. This is good, but we want to change it. Click on cell B1.
Notice that xn-1 is in the edit field (the box to the right of the new buttons).
Backspace over it and type x" (~A1) - 1. We still get 2™ — 1 in cell B1. What
is going on? Here ~A1 refers to value in cell A1 which is n, so that the value of
cell B1 is linked to that of A1l. We want to put 2™ — 1 withn =1, 2, ... 8 in
the second column. Click on Spreadsheet. A menu should appear:

Evaluate Selection
Evaluate Spreadsheet
Row
Column
Fill
Import Data
Export Data
Properties...

v' Show Border
Resize To Grid

vVvyvVvYVYyYy

Select Fill, slide right, and select Down. Did you get the polynomials z—1, 22—1,

., 28 — 1 in column B? You will probably want to resize the spreadsheet.
Click in the bottom right corner, hold the mouse button down, and stretch
the spreadsheet so you can see all the entries. Now we want to factor the
polynomials in column B. Enter factored polynomial in cell C1. In cell C2
enter factor(~B2). Select the column of cells C2, C3, ..., C9. From the
Sreadsheet menu select Fill and then Down. Did you get the desired effect? You
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should now have a table:

n x"—1 factored polynomial

1 z-1 z—1

2 2?2-1 (x—1)(xz+1)

3 a3-1 (x = 1) (22 +2+1)

4 z2t—1 (x —1)(z+1)(22 +1)

5 x5 -1 (x—1D(x*+ 23+ 22 +2+1)

6 25-1 (@-DE+)(@?+z+1)(z?2-2+1)
7 271 (z-D@+aS+at+2d+ 22+ +1)
8 a8 -1 (x—1)(z+1)(22+1)(2*+1)

For more information on MAPLE spreadsheets see ?worksheet,spreadsheet.
For programmers there is a spreadsheet package called Spread. See Section
17.7.19.

1.9 Quitting MAPLE

If you are done with your MAPLE session, click on |l@l] The Save As
window should appear. In the File name box type chl.mws and click on OK.
Your worksheet has now been saved. To quit MAPLE, go to the File menu and

select Exit. Later you can reopen your worksheet by clicking on 1)

In the command-line version, the easiest way to quit a Maple session is to
use quit.

> quit
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2. MAPLE AS A CALCULATOR

2.1 Exact arithmetic and basic functions

As we noted in Section 1.3, MAPLE does exact arithmetic. Also, MAPLE does
integer arithmetic to infinite precision. Try the following examples:

> 2/3 + 3/5;

19

15
> 7 - 11/15;

94

15
>  12720;

3833759992447475122176

The basic arithmetic operations in MAPLE are

+ addition

— subtraction

* multiplication
Aor #x* exponentiation
/ division

MAPLE also has the basic mathematical functions (and much more) that are
available on a scientific calculator.

abs (x) absolute value  |z|

sqrt (x) square root  /x

n! factorial

sin(x) sine

cos(x) cosine

tan(x) tangent

sec(x) secant

csc(x) cosecant

cot(x) cotangent

log(x) natural logarithm
also 1n(x)

exp (x) exponential function e”

sinh(x) hyperbolic sine

cosh(x) hyperbolic cosine

tanh (x) hyperbolic tan

MAPLE has many other built-in mathematical functions. For instance, it has the
inverse trig functions (arcsin, arccos, etc.), the Bessel functions (Bessell),

15
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16 The Maple Book

the Riemann zeta function (Zeta), the gamma function (GAMMA), and the com-
plete and incomplete elliptic integrals (E1lipticE). For a complete listing, see
?index [functions] or Section 15.1.

2.2 Floating-point arithmetic

MAPLE can do floating-point calculation to any required precision. This is
done using evalf.

> tan(Pi/5);

\/5—2v5

0.7265425273

>  evalf(%);

Notice that evalf found tan(w/5) to 10 decimal places, which is the default.
Also, note that in MAPLE, 7 is represented by Pi. There are two ways to change
the default and increase the number of decimal places.

> E := exp(1);
E:=e

> evalf(E,20);
2.7182818284590452354

> Digits := 30;
30

> evalf(E);
2.71828182845904523536028747135

Here E is the mathematical constant e, which is represented in MAPLE by exp(1).
We found e to 20 digits using evalf (E,20). The other method is to use the
global variable Digits (whose default value is 10). After assigning Digits :=
30, we found e correct to 30 digits simply by calling evalf (E).

We can also find an approximation using a context menu (see Section 1.6).
Right-click on e which is the output of E := exp(1). A context menu appears:

Copy
Approximate
Complex Maps
Integer Functions
Conversions

Plots

Select Approximate and press .

> E := exp(1);

vvyVvyyVvy

E:.=e
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> RO := evalf(E,20);

RO := 2.7182818284590452354

Under this context menu the number of digits can be 5, 10, 20, 50, or 100.
We reset the default and calculate sin(7/6).
> Digits := 10:

> evalf(sin(Pi/6));
0.5000000000

> convert(%,rational);

1

2
Notice that after we found the decimal approximation, we were able to convert
it into an exact rational using convert(%,rational). The convert function
is used to convert expressions from one type to another. More on the convert

function is to be found in section 4.6. The interested reader can find more using
?convert. Below is a table of MAPLE’s built-in mathematical constants.

Catalan Catalan’s constant (about .9159655942)

gamma Euler’s constant (about 0.5772156649)
I complex number i (i = —1)
Pi 7 (about 3.141592654)
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